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« OS - Windows7/8/8.1/10

- CPU . Intel Core i5 _E(2.0GHzL % #E12)
« RAM  4GBLL

- I/F - USB7R— + (3fELLE)

o || - HD1080(1920 x 1080) U _E

e FHTHY 7 U T
« LPCXpresso IDE V8.2.2
e TeralTerm V4.98
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e LPC1343D R~y 1%

« CPU :ARM Cortex-M3 72MHz

« Flash :32KB -S5Ol X FHERIE
ﬁ\bw%lJBETSKBiTTEﬁHT

« SRAM :8KB

« GPIO 42K (HEHpind V)

« ADC  :8A& 4pf£8el0bit

« BIE .UART,USB,IZCCS(#
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« VS-WRC103LV A 5 DY

« BIFEEIL3.3V
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« VS-WRC103LV_HEUkirBAE 2 aH 8 THEALAHD 5 ENE
« SE{FERT 3IDEIZLPCXpresso 8.2.2

« LPCXpressod & 7> ao— K
s EETZXILXHHDLLTLETW

. LPCXpresso@/f v X h—=ILAE

EXzie P17 6-2 LPCXpressod A > X b —JL % =08

. X b =g BT TIESKBHIBEA DA 2T L F 5D
% éf i7m77A0>47L47«f; 8KBL/<LE7OLZ> Lﬁ%?%%
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Bz P20 6-3 LPCXpressoDFcEf) & 593
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T — 7 AR — X DER

e TR by &Y [LPCXpresso| % i#cEf
¢« ] —JRAR—A T FILEXDERE
« B 1 C:¥WorkSpace¥ARM _C

e [ZEEDIER] LPCXpressoOD'7 JANR—ZNF/NNRICHAREBHRED
PANENGFNDEIERICEILRTELRWNS

Select a workspac

LPCX; stores your ptoxects in a folder called a workspace,
Cho kspace fold use for this session

Workspace: | C¥WorkSpace¥ARM_C Browse...



O U hOFIRER 1

D QuickStart Panel & ) NewProject% E1R

@ NewProject---BmE & V) LPC1300/1500>LPC13xx>C Project% 23R

New project...
LPC13xx -> C Project

Wizard
Generic-M
LPC1100 / LPC1200
~ LPC1300 / LPC1500
LPC13xx (12bit ADC)
~ LPC13xx
LPCOpen - C Project
LPCOpen - C Static Library Project
LPCOpen - C++ Project

Poopen - ©+ + Jatic Library Project
C Project

Project (Semihosted;

Cancel




7O U b OFIRAER 2

(3 Project namelZ [test0l]| & A3
@ Target selection& ) LPC13xx>LPC1343 % %R
® CMSIS Core library & t) [CMSIS_CORE_LPC13xx| % #E#R#. import% #F

New project... New project...

CMSIS Library Project Selection

LPC13xx -> C Project

Project name: @ Select the CMSIS project that you want your new project to link against, or select ‘None'

New project...
v fault locat
Use default location Select the target MCU The selected library project(s) must be present in this workspace., If
they are not, then click the Import’ button to run the Import Wizard. e
vt Selection Library project can be found within your install directory at */ ki
G ] .

PO Ipcxpresso/Examples/

NXP LPC1343

LPCT1xx CMSIS Core library @
CMSIS-Core Library to link project ni CMSIS_CORE_LPC13xx I v

LPC11xxLV
LPC1200
~ LPC13xx
LPC1311
LPC1311/01
LPC1313
LPC1313/01

XX (12Dt

LPC15xx




Ay FOFRRIER 3

® Project archive(zip) & Y Browseh % > # T

« [ C:¥nxp¥LPCXpresso 8.2.2 650¥Ipcxpresso¥Examples¥Legacy¥CMSIS_CORE¥ CMSIS_CORE_

Latest.zip| #BIU T, NextifFm |

@ Projectdk V) CMSIS_CORE_LPC13xx(CMSIS _CORE_LPC13xx) #3ER L. Finish
CMSIS DSP Library Project SelectionlZ [none] TNext

(© SWO Trace Output TraceldF = v 7 L TNext

]

\ |

Import... =] p4

Select the examples archive file to import p ;
New project...

Projects are contained within archives (.zip) or are unpacked within a directory. Select your CMSIS DSP Library Project Selection
project archive or root directory and press <Next>. On the next page, select those projects you
wish to import, and press <Finish>.

If required, select the CMSIS DSP library project that you want your new project to link 3|
Project archives for LPCOpen and ‘legacy’ examples are provided. @

Project archive (zip)

. 2 The selected library project must be present in this workspace. If it is
ftive s not, then click the ‘Import’ button to run the Import Wizard, CMSIS

DSP library projects can be found in your LPCXpresso install
directory at ‘/ipcxpresso/Examples/CMSIS_DSPLIB

|
Project directory (unpacked)

Root directory Browse...
e MSIS DSP Library to ik project
ibrary to link project tg: No
LPCOpen is the recommended code base for Cortex-M based NXP LPC Microcontrollers. Y Projec o
LPCXpresso includes the LPCOpen packages which can be imported directly by pressing the Browse For more information on the CMSIS DSP Library, visit https)//community.nxp.com/messa

button in the Project archive (zip) section, above, and navigating to the Examples/LPCOpen directory. 630590,

Alternatively, press the button below to Browse the nxp.com website for latest resources.

Browse LPCOpen resources on nxp.com...

@ Bach Next i Cancel

New project...

SWO Trace options

Serial Wire Output Trace

I [] Enable SWO trace clock I @
When enabled, code is included in the startup code which will enable clocking for SWO trace,
which would otherwise be left disabled as the MCU comes out of RESET.

Note - your board support must also set up pinmuxing such that SWO is output on the
appropriate GPIO pin for your hardware.




o <N

A) 7By FDHTERK

> 7 NOFIRIER 4

Other optionsiZinclZF = v 7 % A+ TFinish

N
a-j

2

New project...

Other options

Code Read Protection (CRP)
Enable linker support for CRP

See NXP documentation for your MCU at http://www.nxp com/pages/LPC-ARM-CORTEX-M-
MCUS for more information on CRP

Project Structure

User source directory |src
I Create 'inc’ directory and add to path I

Compiler language dialect
C Dialect  Default

arct

-0 IR B TR

5 Project ..

&5 CMSIS_CORE_LPC13xx
v 5 test01
» Includes
2 inc

v & src

£ cr_startup_lpc13xx.c
lel crp.c
1] testO1.c

@ Quic...

4 Start here

2 Import project(s)

1@ New project...

s+ Build all projects [Debug)
4, Build 'test01' [Debug]

& Clean 'test01' [Debug]

¥ Debug ‘test01' [Debug]

%) Edit 'test01’ project settings

&2 Quick Settings ¥

T et mvnin bttt Fomne VA Thcnsinsi

R ) RS TIRy TR N [ A RS S Quick A

@ Welcome 2 g test01.c
W |filey///C:/nxp/LPCXpresso_8.2.2_650/Ipcxpresso/pages/registeredfreeEditionhtm

A Develop

> B

X X

ot

LPCXpresso IDE (Free Edition) is fully activated

The sof 3 and can be used for production. LPCXpressc
Edit dow 256KB of code lo an LPC target
Product Documentation
The LPCXpresso IDE User Guide provides instructions for using LPCXpresso. Th 2 ailable from the Help menu
Help->LPCXpresso User Guide
Further product documentation is provided within the LPCXpresso IDE via the Heip me

Help->Help Contents

Resources

The NXP community is exclusively built for NXP MCU users, including LPCXpresso IDE, and is an invaluable
resource for getting help and advice on use of the NXP MCUs, tools and boards. So, get connected and join the
NXP community!

* To view the forum, and to register so that you can post, visit NXP Community Forum.
Check the following pages on NXP.com for new NXP MCU software releases, FAQs, and information.
* LPCOpen source and examples.

* LPCXpresso IDE FAGs

* LPC FAQs
* LPCXpresso IDE website.

Links

Vist the Embedded Artists LPCXpresso website

© Console & - J =

No consoles to display at this time.
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@ ProjectExplorer & V) test01 7’
Az baHm7Y) Y7
>Propertiesx 7 U v 7

= Bl D A D

k.4 Develop - test01/src/test01.c - LPCXpresso

1s reported

File Edit Source Refactor Navigate Search Project Run Window Help
v | >R v w » B EPA Ol [Em -
Projec *. Periph. !iiRegist. % Symb.. ¢ test0l.c
f#define ( (* (volatile unsigned int *)0Ox50
5 CMSIS_CORE_LPC13xx §#define GPIOO DATA (*(volatile unsigned int *)0x500
v B testnt
<0 | New ’ 2inf¥E#
@ i Go Into B int main(void) {
v g8 Open in New Window 2 unkignad Int:walt o= 0F o >
Copy Cri+C R—rDA LTI
Pasts tri+V GPIO0_DIR = 0x08;
E ® Delete Delete
4 Source I
Mo while (1) {
Rename... r” |B GRIOD DAIA = D
] for (waita = 0;
Import... GPIO0 DATA =
Export.. for (wait = 0;
Build Project
Clean Project 2 Console
Refresh F5
D Qui..
Close Project | COT Build Console [test01]
4 t | 03 *44% Incremer
Stant
Build Configurations
2 Impot
Make Targets ) :
& New s Index 1| ¥ r“
) . -DDEBUG -D__ CODE_RED -DCORE_M3 -D__ USE_CMSIS=CMSIS
i Build Run As .c: In function 'main‘:
4, Build Debug As -5 g b 'waita' undeclared
& Clean Profile As wait < 3000000; wait++); // R24d,
2 Team
% Debui > : ../src/test01.c:31:10: note: each undeclared identifier
ompare Wil " Imake: *** [src/test0l.o] Error 1
5 Restore from Local History.., |
® Edit 't Launch Configurations > | 03:49:22 Build Finis (took 363ms)
= Quich Smart update >
n Utilities
4° Expor
Tools
4 Expor g

] Run C/C++ Code Analysis ]
LR N 1
I (eleI Properties Alt+Enter VI @

D NXP LPCI

SRR

_CORE_LFC1

(first use in this function)

only once

343 (test01)

= O X
A Develop

3xx -D__LPC13Xd

for each funct:




hin7 7 A ILERL D & DERTE
@ C/C++ Build > Settings& ... ...

Resource

) Build steps > Post-Build o cotom R

Build Variables

. W N
Environment
S e p S > I VA / Logging ¥ Tool Settings # Build steps " Build Artifact [} Binary Parsers @ Error Parsers

MCU settings Pre-build steps
Settings Command:
Tool Chain Editor

C/C++ General

Project References

Run/Debug Settings Description:

11

+

Edit..

BED3TDS B, 2~31T
HOEEICHD # X & S
Sl S | < N

Notes:
- Commands are executed by a Linux compatible shell
(not the Windows command processor).
| - A comment character (#) disables ALL FOLLOWING COMMANDS.
| - Enter one command per line.
- After editing, commands are concatenated with a ' separator.

| arm-none-eabi-size “${BuildArtifactFileName)”
# arm-none-eabi-objcopy -v -O binary "${BuildArtifactFileName}” "${BuildArtifactFileBaseName}.bin"
# checksum -p ${TargetChip} -d "${BuildArtifactFileBaseName}.bin"

Restore Defaults Apply

Concel o



JbTho~A a0 530

#ifdef USE CMSIS

. ;]ZIJ HTDH /r 4 70 ] 7\\ 4 i :Zzgi:de_"LP613xx.h"
N A\ — ~ W — —
/ 7 & — Z" j: L E DE 7— jj 7— jj #include <cr_section macros.h>
/\\\/}jéﬁ%d)‘?b ‘T\\—g— /] LI ARESE
# . * . . . *
» HAAIZHBT B [Hello World] | kactine crroooama (s (voratite unsisned int *)ox50003FEc
T\—a_ // mainBI%K

int main(void) {
volatile unsigned int wait = 0;// FHbREHEOZEH

° testOl.cL:E@ V) — X O — N /) F— FDOARNBE

GPIOO DIR = 0x08;

EFTHAA CEFEHR LT e
0—9‘ i [/ J: 7 Whil:;z)oiDATA = 0x08;// LED%OFF

for (wait = 0; wait < 1000000; wait++);// &b
GPIOO DATA = 0x00;// LEDZON
for (wait = 0; wait < 1000000; wait++);// &b
}

return 0 ;




o <N

» ProjectExplorer & V)
testQ1l 70> 7 b %&
7AN

e X Z” 31—

Project>Build Project

7 Uy
e ZNICKYEEDTO
T FPOEIFAX
K — h

/

Tt FOEI R

X Develop - test01/src/test01.c - LPCXpresso

R % Open Project
e Pr
& Projec.. &2
* s Build All Ctrl+B
S CMS! . Build Configurations
< CMSIS_COR s Bliid Project
v & test01
> Build Working Set
% Binanes
Clean...
# Includes
o Build Automatically
2 inc
v B src C/C++ Index
g cr_sta Properties
[& erpc
L testOl.c
& Debug
O Qui.. =
4 Start here

® Import project(s)

& New project...

i+ Build all projects [Debug]
4, Build 'test01’ [Debug]

& Clean 'test01' [Debug]

% Debug ‘test01' [Debug]

 Edit 'test01" project settings

&2 Quick Settings ¥

Wiritable

File Edit Source Refactor Navigate Search Project Run Window Help

= O X
BEP L B0 Q|G ™y aliil vy vy || = | & Develop
@ Welcome g test01.c & —a
#define GPICO_DIR (* (volatile unsigned int *)0x50008( o
fdefine GPIOO_DATA (*(volatile unsigned int *)O0x50003FFC)
nfif%
int main(veid) ({
unsigned int wait = 0; HOEZY
GPIO0_DIR =
4R y)
while (1) {
GPIOO_DATA = 0x08; LEDZOFF
for (wait = 0; wait < 3000000; wait++):
GPIO0 DATA = 0x00;
for (wait = 0; wait < 100000; wait++): v
2 Console =2 2 = k=
A k| B vmv
CDT Build Console [test01]
MFlash32: 1040 B 32 KB 3.17% PN
RamLoc8: 0 GB 8 KB 0.00%

Finished building target: testOl.axf

make --no-print-directory post-build

Performing post-build steps

arm-none-eabi-size "testOl.axf" ; arm-none-eabi-objcopy -v -0 binary "testOl.axf" "testOl.bir
text data bss dec hex filename
1040 0 0 1040 410 testOl.axf

copy from “test0l.axf' [elf32-littlearm] to “test0l.bin' [binary]

Written checksum Oxefffd2b2 at offset Oxlc in file test0l.bin

Previous value Oxefffd2b2 at offset 0Oxlc in file testOl.bin

03:56:33 Build Finished (took 1s.336&ms)

< >

Smart Insert 31:17 O NXP LPC1343 (test01)




CL R IESW 7 & RSS!

e EILMAERICKRT T
N9, BinZ 714 IILH
ZNIERIN T

« EILRAKMICKRDD &, MBRICOVWTHRIYT—7T7 v 7 &
N5,

E. ConsoleDEZD LSO 7 A
£ ST, Build Finishedd XA R

,//
PrQN

£ Console =2 ¢ K = = n —
3 4 95| & BB k| " Bvrm © Console & = = n
CDT Build Console [test01] & | LH &l k| M B~
MFlash32: 1040 B 32 KB 3.17% A CDT Buiid Console [test01]
RamLoc8: 0 GB 8 KB 0.00% 03:49:22 *+++ TIncremental Build of configuration Debug for project test(l *+++
Finished building target: test0l.axf make -r all
Building file' ./src/test0l.c

make --no-print-directory post-build Invoking: MCU Complxer
Performing post-build steps arm-none-eabi-gcc -DDEBUG -D__ CODE_RED -DCORE_M3 -D__USE_CMSIS=CMSIS_CORE_LPC13xx -D__LPC13X)
arm-none-eabi-size "test0l.axf" ; arm-none-eabi-objcopy -v -0 binary "testOl.axf" "testOl.bir ../src/test0l.c: In function 'main':

text data ss dec hex filename ../src/test01.c:31:10: error: 'waita' undeclared (first use in this function)

1040 0 0 1040 410 test0l.axf for(waita = 0; wait < 3000000; wait++); // $R2%d.
copy from ‘testOl.axf' [elf32-littlearm] to ‘test0l.bin' [binary] »
Written checksum Oxefffd2b2 at offset 0Oxlc in file test0l.bin ../src/test0l.c:31:10: note: each undeclared identifier is reported only once for each funct:
Previous value 0Oxefffd2b2 at offset 0Oxlc in file test0l.bin make: *** [src/test(l.o] Error 1

03:49:22 Build Finished (took 3é3ms)
03:56:33 Build Finished (took 1ls.336ms)
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RAZA

P100_3

+)’%,J3

LEDZ2

RAZD
68

68
RAZC

P100_7

« GPIOIZ & ALEDMEE
e LED]1 : #DLED
e LED2:FL > DLED

« VUV UBEMRICK D KTHIE

O Vcec=3.3V

b 4
b 4

—OD

: Low(0V) :( )

7 High(3.3v) ()

e LEDICENAEBEREARETE
« V=R*| — 3.3[V]-2[V]=136[Q]+I[A]
e 1=(3.3-2)/136=9.55---[mA]
. LPCl3430>//7 EBRDEAE

1p|n%7‘_‘) AmALLF
e T—X>— bFDIOH=-4mA L )

« LD L. IOHS=45mATH 5%, FERIER
ML\ ANTASmMAE TH
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c IR EICIZEERB(FL D) D2DODLEDAEE N TH Y.
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« ZZTlE, v IUBEMRICLEALEDRAT[E E%ﬁ 4%)5\/2'«5_:_*1/’(?3 IR
OR—Fh5'0%HANT D & LEDDMIRIC3.3VD B AN FE-
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CdLEDIZBXT I 2HEAICHE > TWET,

« FXLEDZ RXTE ¥ 5 ICIE. AN EHNT D
« #FKLEDZEAT &8 5 (T, AN EHNT D
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GPIO & &

« GPIOI£General Purpose I/ODEE T,

o GPIOIZAERICH LT, "I'NO0ODIEEZHNTHENTEET,

« LPC1343~ A Ol 12bitDR— K A3t v bk é:4b|t0)1‘— A1ty b ATE
N THY., FNEnNPIOO, PIOL, PIO2, PIO3E ZEiAMTIT LN TUWLWE §,

. %7%%:3— NEEY FZTEICREBTAICIER—MLOEY FODIFE, PIO1_0& K

F FIELPGLA3Y £ 2 Th, K> *&@ﬁ WHVOFN33/ty 7 — 2 D354, PIO2

£ X OPIO3(E1bitd R — 2| ﬁ AN TENUBETT,

Table 146. GPIO cenfiguration

Part Package GPIO port0 GPIO port 1 GPIO port 2 GPIO port 3 Total
GPIO
pins

LPC1311, HVQFN33 PIO0_0to PIOD_11 PIO1 010 PIO1_11 PIO2 0 PIO3 2;PIO3 4; 28

LPC1311/01 PIO3 5

LPC1313, LQFP48  PIOD_0to PIO0_11 PIO1_0toPIO1_11 PIO2_0to PIO2_11 PIO3 0to PIO3 5 42

LPC1313/01

LPC1313 HVQFN33 PIO0 0to PIOD_11 PIO1 010 PIO1_11 PIO2 0 PIO3 2;PIO3 4; 28

PIO3 5
LPC1342 LQFP48  PIO0_0to PIOD_11 PIO1 0toPIO1 11 PIO2 Oto PIO2 11 PIO3 0to PIO3 3 40
HVQFN33 PIO0_0to PIOD_11 PIO1 010 PIO1_11 PIO2 0 PIO3 2 26
LPC1343 LQFP48  PIO0_0to PIOD_11 PIO1 0toPIO1 11 PIO2 Oto PIO2 11 PIO3 0to PIO3 3 40

HVQFN33 PIO0_0to PIOD_11 PIO1_0to PIO1_11 PIO2_0 PIO3_2 26
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SWOIOPI01 _FVADWCTI2B1 MAT2

38 PIOZ_3aRI
P03

PIO1
'V'D[.
PIO3 2
40] PIO1_4MDS/CTIZB T MATUWAKEUP

2! PIO1 11/AD7

41 ;| Vss

PIO3 3
7] PIOT_T7/TXI

3B PIO3.
7
45)
44
45]
42
39
=

R = N

s' P26 [1] %] P03 0
% 3 % T PIO2 QDTR [2 | (35] RIPIOT_20ADI/CTI2B1_MAT!
7N RESETPI00 0 [3 34| RIPIO1_1AD2/ICTIZB1_MATO
c —

/J \ PIO0_1/CLKOUT/CTS2B80 MAT2ZUSE FTOGGLE | 4 33] RIPIOT QADT/CTI28Y CAPO
/ Vss [5_ 32] RPIOG_11/ADICTI280_MATS
XTALIN [& | 31] PIO2_11/SCKD
S LPC1342FBD48 Z] % SRR
,& XTALOUT | 7 LPC1343FBD48 30| PIO! _10/ADG/CTIE81 MAT

Voo | 33! SWCLK/MO0_10SCKWVCT16B0 MAT2

= PIOT_B/ICTI6B1 CAPO | 9 (28| PIO0_SMOSIBCTI1680 MAT1/SWO
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Fig 10. LPC1342/43 LQFP48 package
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PIO0D L “‘X fzfr

ortO 0x5000 OOOO

GPIODIR 0x3000 0x00 port 1: 0x5001 0000
port 2: 0x5002 0000

GPIODATA 0x3FFC R/W n/a port 3: 0x2003 0000

c T TWOHLIYZREEIFNALYXZEIFELR Y. GPIOZ4|EHT 54

@%%#%Uﬁutiﬁwv@xﬁtﬁUiT&
« BDAD DY N— X PPWM E LS 7HERES . £ CHIEIL P XX PR S

gﬁy\_wuyxﬁcﬁéégkhﬁu %EE 7 AN tfﬁ%

']' \

-vig/%ﬁgﬁ%am\v?xﬁwﬁ@%%i%%uﬁﬁuﬁgaﬁ4

e
. (%P?J_Od)ﬂlw/xﬁ IX. base address + 7 KL XA 7+t v F CEHAAIEE

« PIOODDIRLYXZD7 FL X 0x5000 0000 + 0x8000 = 0x5000 8000
« PIOODODATAL Y XZ®D7 KL X :0x5000 0000 + 0x3FFC = 0x5000 3FFC



GPIODIR (GPIO data direction register)

c ZUDR—FDOEEY MRIFEF)NVADR— b THBH, H
/_J_S_ I\T\\%%ﬁ\%gﬁk—?[/i—a—o
e XTI T BAE Y b, TNZENIT/NRT N T DERENAIEE
« 'ODIGEIZATR— K
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« YJERMEIZXOX00TH 5 &, BREIEAEIZIATIR—FDERT,




GPIODATA(GPIO data register)

« HAOR— L DFE
s ZIHDER—PDERL Y RAZIMEZEZALZ LT, EICK>TEY |
ML > T=R— FiFFPIOn 0~11ICHAh I N E T,

s AR — M DFE
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2B T HEVEEKRET,




B 88 testO1.c

#ifdef __USE _CMSIS
#include LPC13xx h"
#endif

#include <cr_section_macros.h>

/] LYPRARERER
#define GPIOO0 DIR (*(volatile unsigned int *)0x50008000)
#define GPIOO DATA (* (volatile unsigned int *)0x50003FFC)

// mainB9%L
int main(void) {
volatile unsigned int wait = 0;// FHREAOZEE

// R—bDABNEE
GPIO0 DIR = 0x08;

// ERL—T
while (1) {
GPIOO DATA = 0x08;// LED%ZOFF
for (wait = 0; wait < 1000000; wait++);// &bH
GPIOO DATA = 0x00;// LEDZON
for (wait = 0; wait < 1000000; wait++);// &b
}

return 0 ;

« GPIODH|HL ¥ X X 0)
o #define GPIO0 DIR --
e #define GPIO DATA ---

-GPIOO)%'J{EIH/ CAZANDT 7R
Hﬁ%';ﬁﬂl/“‘ (S L TEHD &S

. GPIOO_DIR = 0x08;
« GPIO_DATA = 0x08;

—;'EH-}FIEﬁ@'T/IEE\/Z_’ SL—=7

e for(---); Al LA WLWALEE
e volatilefEEhF

« OV ZTD&mEALZFF



CMSIS-CORED &

S8 B LYV A EFERTAEIC, LY XX Zdefine TE
xIDDHEHLHY £, l//xﬁz@&;t#% ZIZIZE )
defineX CFE&ET A7 T’C% HH T,

« ARM Cortex-M< ) — X (Z1ZCMSIS-CORE & ME (I A{EF 7577
BOTFEET S
e #include<LPC13xx.h> O BAZ B THh LD |




CMSIS-COREZ 74
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// CMSIS-CORE%*ERL7-%5&
#ifdef __USE CMSIS
#1nc1ude 'LPC13xx.h"
#endif

#include <cr_section_macros.h>

int main(void) {
unsigned int wait = 0;

LPC_GPIO0->DIR = 0x08;// R"— AL

while (1) {

LPC_GPIO0->DATA = 0x08;// LEDZOFF

for (wait = 0; wait < 100000; wait++);// &b
LPC_GPIO0->DATA = 0x00;// LEDZON

for (wait = 0; wait < 1000000; wait++);// &bH
}

return 0 ;

NPACIIN

7144 :rei0l 0l.c
L~

i AR % L.
12]]71 Z ILal %jgl_ﬂﬂ/ TD)

« LPC_GPIO0->DIR = 0x08;
« LPC_GPIO0->DATA = 0x08;

LPC13xx.hN 24 T a2l & A

J
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« ZRREOL I RLED/Z LF 2 sl g 5 700 7 A

« SERH02 I BLED & RLED Z R IC sl 2 7 07 Z L
m. SOBJEERIIIERD2EE I B

« (2RE03 : BBLED & RLEDZRR B I mGEHT 57 a7 7 A

« Z27E04 : LEDHIE A 1T - B3 & 1E Rk
 void init_led(void):
 void set_led orange(unsigned char value);
o BLED®D mATHITE 2 1T 5 BIEK

o BIEDODE, JEXT, 1D, =47,

 void set_led _green(unsigned char value);
o FKLED D | kTHIE 7z 1T D BE%K
o BIEM0DEF., BT, 10K, =AT,
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h 7 LEDARE. Sl
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e e | T I
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v 77 LAY

PAD
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FFEIA BB

« void init_exled(void);
 void set_exled_full_color(unsigned

LED1
[ ] [ ]
o o
~ O

\>
%lﬁ

°
)
oo
1::1

1 =S WK char color);
2. ) . % > 1: 2: 4.
AME 2 VRS A 2%

GND
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e 1ei0l 0l.cmEAR—XELTITF-TLEETW

e AAXRDA—T7ZHHAWVWTCIRETEDO BB RET S

e ZL—TOREERAZEL. ImsOwaitBEEE A /ERT 5
« 7 74 J)%:kadai0l 08.c

extern inline void wait 1lms();
inline void wait 1ms() {
volatile unsigned short i;

for (i=0; i< ;oit+)

e ImsU FDEEDRFROwaitdT 2FEATX B, wait ms() Z1ERE L,

Waiti&@ 35 5 1ms & 9 5, i
« 771 J)L%:kadai0l_09.c

extern inline void wait ms(unsigned short ms);

inline void wait ms (unsigned short ms) {
// 3 3ITER

}
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EH%
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wmi

e FHE 358

USB-Serialz v 77w 7 &

9 COMs:9600baud - Tera Term VT

t::t tE:tI::E:}:I: Window KanjiCode Help
........... . 1. USB-Serial®3pin(TXD) & 4pin(RXD)%# > 3 — b xH 3
................. 3. (RS A NEA)
© © 0 0 06 © © 0 0 © © 0 0 0 0 0 @ . E%L:E]\i%%kwi%é‘ixg

4. TeraTermicH)
« YUTFIEERTEIZT 7+ b
e X— IS IEKTFEL LocalEcho : 1]
5. ANMXFEZFTHEIAARX— I FIL EICEKRINAILETS
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RedLibE > ZILDT /N K FE A

& Debug 11
15 return 0 ;
16 }
O Qui.. 27 t#Var. % Bre.. S=Outl. Exp. — O
E3 Start here =

2 Import project(s)

&l New project...

i+ Build all projects [Debug]
4, Build ‘test01' [Debug]

& Clean 'test01’ [Debug)

% Debug ‘'test01' [Debug] Console 2 o

2 1 nate, Bulld and D 1 'test(l! [Debug
CDT Build Console [test01]

" e
DS W Dyect Stinge alloc.c:(.text. Csys_allo

c:/nxp/lpcxpresso _8.2.2 6
fseek.c: (.text.fseek+0xla

& Quick Settings v I@
-
@ Detined symboss {test0] Debug) fseek.c: (.text.fseek+0x44

% Undefined symbols [test01 Debug] ) collect2.exe: error: ld r
£ Include paths [test01 Debug] vl %

® Library search paths [test01 Debug]

% Libraries [test01 Debug]

>

@ 3> % Redlib (none)
% Newlib (nohost)
% Newlib (semihost)

% NewlibNano (none)
% NewlibNano (nohost)

® NewlibNano (semihost)

e VU TIBEDY —RXRO—KAEHEF 74K

NoX7ryA—kFd5

e uart.h, uart iohz 780> 2 FDinclZ AN %
« uart.c,uart io.cx 7B 7 FDsrcl A5

* RedLibZ AT 5 5REZ1T D

e Quickstart -> Quick Settings -> Set
library/header type -> redlib(semihost) % EiR

AT L
O — LB

RedLib

[RedLib]

CodeRedttA"EE L /-1Z#C T 4 7 7 U —printfPscanfz 12t

[ UTFILDF/NEF]

RAAVDA—H—PFEAR— FOA—H—DREI—FZFAT 2H, HMEEET S

[~ 25 L a— L EE#])
RedLib®printf>scanfh SN & 1 5 BI%4.
Y TILDTNEZ ERedlibDiEEL, BETERET S
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#ifdef
#include
#endif

#include
#include
#include
#include
#include
#include

/] VAT
int _ sy
{
int
for

}

retu

}

int _ sy
retu

}

USE_CMSIS
"LPC1l3xx.h"

<stdlib.h>
<stdio.h>
<string.h>
<cr_section macros.h>

"uart.h"
"uart_io.h"
La—ILDER
s_write(int iFileHandle, char *pcBuffer, int iLength)
n;
(n = 0; n < iLength; n++) {
if (pcBuffer[n] == '¥n'){

uart putchar('¥r');

}
uart putchar (pcBuffer([n]);
rn iLength;

s_readc() {
rn uart_getchar();

// mainfa#

int main(void) {
char str[l1l6];
int a;

// Y T ILEEDHERL
init _uart_io(9600) ;

printf ("Hello World.¥n") ;

// scanfll &% XFF DI
printf ("input your name:") ;
scanf ("%$s", str);

printf ("-> %s¥n", str);

// scanfll X 2EHDEUS
printf ("input num:") ;
scanf ("%d", &a);

printf ("-> %d¥n", a);

printf ("¥n¥n--- bye.¥n");

return 0 ;
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Uml

B 2E:rei02 01.cd

TeraTermDFRI N B FEE TeraTermD & TE
;-__ : .- ’ - e Terminal size MNew=line R
.. | ._ M n . J > - - i —— |BD ‘ b |2£1 ‘ Receive: ||F w
el 1o forld.
n ; M Term size = win size Transmit: CR+(F « Cancel

VOUIE name:s o I LZI_:EJ_'."'.'EJ. . .
Auto window resize

| rit
Help
Terminal [D: ¥T100  ~ H Local echo
Answarback: ‘ | O Auto switch (WT<->TEK)
Kanji {receive) Kanji {transmit)
UTF-8 «~ UTF-8 ~ 4B
7hit katakana 7hit katakana 1B

locale: |japanese CodePage: 732
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1. %rintf()&ﬁ%'?ﬁ(%, IWT, B8N ed 570707 LxERL T
LY
-« [ A A =]

2. VU TFTILBETPCLY EgNELNTE-BIFKOLEDZ T4 57
D77A%T’F}3€Jdct

3. ONELSNTE=BFLYIDOLEDZ 24T 5
A, "B ELNTZEI-6LEDZBATT 5



orintf 7 /3w 7 DB 8

U TILBEZERL zprintfB8%%. o &I#EI(GPIOAD A
E)EEERFEFR ITIE L,
SUTILBEZZRTSE. VAT LOFEICKELGEENH
HAJEEMED D B,
e TNy TEICIXERTEAY Y —XBFICIL, printfO IR A E3p{b 3 5
HmEDLIRDILE

#ifdef DEBUG

#define debug printf(fmt, ...) printf(fmt, VA ARGS )
#else

#define debug printf(...)

#endif
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)28 rei03 01.c

#ifdef _ USE CMSIS
#include "LPCl3xx.h"
#endif

// BEITERR L 7-BEL & I3E K
int main(void) {

init led();
LPC GPIO0->DIR &= ~0x0002;

while (1) {
if ((LPC_GPIOO->DATA & 0x0002) == 0) {
set led orange (LED ON) ;
}else{

set led orange (LED OFF);
}
}

return 0 ;

e A4 wF(SWDAEHETLTWS
H. BLEDA K] T5 7077

« DIRL Y X X DEXTE
« LPC_GPIO0->DIR &= ~0x0002;
« GPIO0M2bitH = AJIERE IC

* DATAL X ZH o DigdH L

« if((LPC_GPIO0->DATA &
0x0002) == 0)

« GPIO0OD2bitB D A JJIRRED A %
jiilan

« SWIAHT TH 5 H 2 Fkhr
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// mainBa%K

int main(void) {

// IHAfE
init uart 10(9600);
init led();

LPC GPIOO->DIR &= ~0x0002;

// BIRRORZ IRTREL
set led orange (LED ON) ;
set led green(LED ON) ;

while ( (LPC_GPIOO->DATA & 0x0002)
while ( (LPC_GPIOO->DATA & 0x0002)

set led orange (LED OFF);
set led green (LED OFF);

// printfI&xx

printf ("Name:Kumikomi Taro¥n") ;

/l/7|:|77 7 LT

1= 0);// WTHFH
0);// ¥ZzEITEFH

printf ("Age:5¥n") ;
printf ("From:Kumamoto¥n") ;

return 0 ;

Uml
|

N1EL7-LTC

eFa—fEILX—2TEI 2

—

mf%ﬁ
i}uT@7m —TCEIfEFZ= L T
L7
1. BER&EA
2. 1& - #XLED=AT
3. RE&YRAvF(B)ET
4. & - #XLEDBEAT
5. EXRAALTOY S LNES
COEEIZEDO—FD LD
EHETZX S
« kadai02 0l.clC#BEENN L /-5
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// FRRE03 03 HKERELEE

#ifdef __ USE CMSIS
#include "LPCl3xx.h"
#endif

#include <stdlib.h>

#include <stdio.h>

#include <string.h>

#include <cr_section macros.h>
#include "uart.h"

#include "uart io.h"

// EiR_EOLEDHIEER (F D E L
#define LED OFF0// iHT
#define LED ON1// m*T

// 7Ly RR—FLED7/)LA5—LEDSIHEE T DE

#define LED BLANKOx00// HXT
#define LED REDOx01// 7rts
#define LED_GREEN0x02// fFf

/1 A Ay T B A

void init button (void) ;

unsigned char get button black(void) ;
void init ex slide switch(void);
unsigned char get_ex slide switch(void) ;
unsigned char is_ex_slide switchl_on (void) ;
unsigned char is_ex_slide switch2_on(void) ;
unsigned char is_ex_slide switch3_on (void) ;
unsigned char is_ex slide switch4 on(void);

- kadai03 03 ex.cT2401TIEED
lpwwrw | — N DO IDDH D

unsigned char i =
unsigned int msec

e « £ 72, LED/printf/Switch® JxC

LED RED, LED_ YELLO /
i/ - F OHAT
in;j/.gned chaJ'E:J flas % L) ’fﬁ i 711_ i 71— j:$ Z_ % S ! !

init uart io(9600) ;

#define LED BLUEO0x04// Ff& init led(); 2
#defineLED PURPLE (LED RED | LED BLUE)// ¥ init ex led fullS X ( \J \
#defineLED YELLOW(LED RED | LED_GREEN)// HfE init_button();

#defineLED LIGHT BLUE (LED BLUE | LED GREEN)// K& init ex slide s
#defineLED WHITE(LED RED | LED BLUE | LED GREEN)// HE
set_led_orange (

while (1) {
[ | == e es e e e e e s s S e e e e S S e S S S S S S eSS CSSs /) ====m=====s
// 7ALRATES // FRE03_0
At set led gre jpo g
// LEDHIERI%EE printf ("swl:%02X, ", get button _black()) ;
void init_led(void) ; printf("ssw:%02X¥n ", get ex slide switch());
void set led orange (unsigned char value); printf(" sswl:%x, ", is_ex slide switchl on());
void set led green (unsigned char value); printf (" ssw2:%x, ", is_ex slide switch2 on());
void init ex led full color(void); printf (" ssw3:%x, ", is_ex slide switch3 on());
void set ex led full color (unsigned char value); printf (" sswd:%$x¥n", is_ex slide switch4 on());
printf("=——=== ¥n") ;
// WaitBAEEE set_led green (LED OFF);

extern inline void wait_ lms (void);
extern inline void wait_ms (unsigned short ms);



177 A D FENER
5 ERFENED, XV T T
Y ALFEWL, ENITHFAELFE
L, & W 7AlEmAIRN S

e Xk e LT, O—FZ4E
BD7 7 AIICDEIL, D8

BETLFE
+ F—LRARBICHEENTH Y,

S5
« 7 7 U /ZTA/E\ZIM*‘EE
L9 <5



<<include>>

» calc.h

<<include>>

fcalc.c

c Ny X T 7 AI

s BT A—/NILRR, TR XA
7 = E%maﬂ—a_%)

e includefi— K &#3CRd %
« ) —XT7 7 A
« IO EMRL & =72k



CEiEl

main.c

calc.h

BIT257 74 IIL95EQ2

calc.c
#include <stdio.h> #ifdef  CALC H Includesi — I~“| #include “calc.h”
#include <calc.h> #define  CALC H

int main(void){
int a;
a = add(1, 2);
printf(“ans:%d¥n”, a);

B DM U L

return O;

int add(int x, inty);
7O TES

#endif

int add(int x, int y){
return x +v;

} SR DA fh
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%g‘%%IE AH—ICET 2EECER
e LED®"XA vF, =XKL
e ex_dock
PRUT Ny TRAQE Y 7 ETEREY 5
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e wait
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e Stdcall
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Temperature (T) Typical Vg
+100°C +1600 mV
+85°C +1450 mV
+25°C +850 mV
0°C +600 mV
-25°C +350 mV
-30°C +300 mV
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ls ¢ = get center line sensor(); \

ls r = get right line sensor(); b }EE&k%%:’tZ :// j
temp = get temperature () ; ° EE%&—E \/ H
dist = get distance();

printf("vol:%4d, 1:%4d, c:%4d, r:%4d,", vol, 1s 1, 1s ¢, 1s r);
printf("temp:%4.21f, dist:%4.21f¥n", temp, dist);

wait ms (500);
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return 0 ;
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Temperature (T) Typical Vg
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+85°C +1450 mV
+25°C +850 mV
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Example of output distance characteristics of GP2Y0E03
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« 10.6VDE;, ¥{& % T50cm

— c ZDT T T7DY R EMEEEKRD S

~—_ y=ax+b b=2.35

T~ 2-10a+b  y=-0.035x+2.35

0.6=50a+b

10

a=-0.035 y:EBF, x:IEEt
20 30 40 50 60 -
Distance to reflective object®1 [cm] o Y é_’_ X 72 A *legﬁ Z_ %) & oo
*1 : Using reflective object : White paper (reflective ratio : 90%) . X: (_ 200y+470) /7
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FIEQ : a< > FTE— X

int main(void) { case 'd': /\\ = NV AN \ -
char cmd; rotate motor (MOTOR LEFT, FREE); /Z —a_ LTC 7& /?75 L/ T Ej'] 75 —a_ — é:
printf ("> LEFT FREE¥n") ;
init syscall(); break; T T 75\ ~ N P %
init motor(); eralerm ) A~
init ex led full color(); case 'e': ﬂ'-['o ﬂhf@]’ﬁzfﬁﬁﬂ
rotate motor (MOTOR RIGHT, CW);
set ex led full color (LED LIGHT BLUE); printf ("> RIGHT CW¥n");
break; ~ > BEE \ N |
printf(" _____ ¥nu) E case 'f' : :I 7 / |\ E}Lj:’[//{—F@ﬁ )
Pr%ntiiu*** M;to]): Control TEST ***¥n") ; roFaEi_(mit;iébénglév_quG?T, CCW) ; . Lay E:E— g J—_E$ﬁ
prln W e nu E prln 1] nu : . , ] R _
while (1) { break; e ‘b ' — X JEEL
printf ("input command:") ; case 'g': e ‘N . - > -
scanf ("%c", &cmd) ; rotate motor (MOTOR RIGHT, BRAKE) ; c E :E & 7 l/ ﬂF
printf ("¥n") ; printf ("> RIGHT BRAKE¥n"); e ' T — R T —
break; . . —
switch (emd) { case 'h': ° e E:E — ﬁ J—_E$K
case 'a': . ro’_cate_llt'lotor (MOTOR_RIG?T,. FREE) ; o« ‘f :E:E — g ﬂﬁ$ﬁ
rotate motor (MOTOR LEFT, CW); printf ("> RIGHT FREE¥n") ; . -
printf ("> LEFT CW¥n"); break; e g :Z':T:E — X JL—=F
break; } (AP .
case 'b': } * h E:E—g 7 U—
rotate motor (MOTOR LEFT, CCW);
printf ("> LEFT CCW¥n") ; return 0 ;
break; }
case 'c':
rotate motor (MOTOR LEFT, BRAKE) ;
printf ("> LEFT BRAKE¥n'") ;
break;
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void forward(void) ;
void back(void) ;

void _turn left(void);
void _turn right(void);
void stop(void) ;

void free(void);
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$REQ2) : GPIO+Wait(Z

while (1) {
mode = get ex slide switch();
vol = get volume ();
if (vol <= 0)
vol = 1;

//printf ("%$x, %d¥n", mode, vol);

switch (mode)

{

case OxO0f:
_stop () ;
break;

case 0OxOe:
_forward() ;
break;

case 0xOc:
_forward() ;
wait ms (10);
_stop () ;
wait ms (10 * vol / 1000);
break;
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1. While/b—7ICHAAD X, FHI20msec, T2 —7 1 Lk50% CTE —
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void forward 20ms (void) ;

void back 20ms (void) ;

void turn 1eft_20ms(void);

void turﬁ:right_20ms(void);
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e 2 —FA—/"N"—ARM (T A4 X} >#)
e https://www.vstone.co.jp/products/beauto rover/index.html
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« LPCXPresso(NXP#t)
o http://www.nxp-lpc.com/Ipc boards/lpcxpresso/

c ARM~ A VL BAAT AT T IV 7 AFI(H— Ltt)
e http://shop.ohmsha.co.jp/shop/shopdetail.htm|?brandcode=00000000146

1&search=ARM%A5%DE%A5%A4%A5%B3%A5%F3

« Special Thanks
« SSEST5(Summer School on Embedded System Technologies)
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